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Exploring is a career education program for middle and high school–age young men and women based on a unique and dynamic relationship between youth and the organizations in their communities. Local organizations are matched to the interests of young people in the community using the Career Interest Survey, either in Scantron format or online. The result is a program of activities that helps youth pursue their special interests, grow, and develop. Many times these programs provide a hands-on experience, career preparation, and college endorsement.
Success in organizing Exploring posts/clubs and identifying career seminar topics starts with the ability to identify the "market"; that is, being able to determine the career interests of students. The best method for Learning for Life to achieve this is by conducting an annual survey of all middle and high school students.
The purpose of this survey is twofold: to support school counselors in their work and to grow membership in the Exploring program. Survey results are generated into a variety of reports including the following information: student names, addresses, phone numbers, grades, ages, after graduation plans, and schools. This information is used to invite students to join Exploring posts/clubs in their interest areas. The Career Interest Survey provides the best method for collecting market research. By utilizing the survey in each middle and high school in your area, your local program will have:

· Purposes for Councils
· Provides contact information of students who could be invited to join a Post, a club, or even a crew. 
· Demonstrates to prospective participating organizations just how many high school students could join their program.

· Builds relationships with participating schools.

•
Purposes for Schools
· Helps schools meet their state law to provide a four-year course plan for high school students.
· Identifies popular career interests that may result in new and relevant career elective classes.
· Provides data for grant writing.
· Benefits to Schools That Participate
· Survey is conducted at no or little cost to school.
· Results are not sold or given away.
· Scantron or online survey options are available.
· Survey takes only six to 10 minutes to complete.
· The Scantron and online surveys both have a place for schools to ask students any six (6) questions requiring a “Yes” or “No” response.
· The survey results can be very helpful for guidance counselors when meeting with students about career and college planning or planning college and career fairs.

· The survey will connect most students with real-world career experiences in popular careers through the Exploring program.
· The survey may help counselors meet state mandated requirements for career planning.
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	Online Career Interest Survey
	Scantron Career 

Interest Survey

	Cost to council
	($600-$1,000 unlimited surveys)
FREE in 2016 for Exploring Explosion  councils
	Cost of forms
($2.49/30 pk
SKU 618833)

	Helps schools meet state law to provide a four-year course plan for high school students
	(
	(

	Survey is conducted at no or little cost to school
	(
	(

	Results are not sold or given away
	(
	(

	Takes six to 10 minutes to complete
	(
	(

	Place for schools to ask six (6) Yes/No questions
	(
	(

	Council generates its own reports
	(
	(

	Reports available: alphabetical roster, roster by hobby, roster by career, school summary, etc.
	(
	(

	Scanning
	
	Free through National with

2-3 week turn around

	Over 200 career choices
	(
	(

	53 hobby choices
	(
	(

	Survey accessed over a secure website for safe access
	(
	

	Student may access survey 24/7 to complete the survey
	(
	

	Students under 13 years old may take the survey
	
	(
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Learning for Life must build and continue to maintain strong relationships with school officials. All the work that goes into the Career Interest Survey can be endangered if the school refuses to survey or does an incomplete job. The Exploring Committee must continually promote the purpose of the survey as a service to the school and to local Exploring posts/clubs to strengthen the school’s career education efforts.

For Exploring, the survey provides a "market analysis" to determine what kinds of posts/clubs to organize in the communities surrounding the schools that participate. For example, if 200 students list law as a career choice, then the council’s Exploring Committee knows to look for an organization, such as a law firm, bar association, etc., that could organize an Exploring program specializing in law. Similarly, if students express an interest in law, local lawyers might be invited to present at career fairs or other speaking engagements on behalf of the Exploring program or the schools.
The market is determined by tabulating results from the student Career Interest Survey. The names and addresses of students interested in each subject are available during the organization of a post/club or development of a senior high school program so they can be invited to join.

The Exploring Committee may organize a task force to help with the Career Interest Survey. The role of the task force would be:

•
To establish the best method for distribution and collection of the surveys

•
To develop support material for the school and teachers to assist with the implementation of the survey

•
To cultivate relationships with school administrators to ensure the survey's completion

•
To review the processing of the survey

The task force should include administrators who have influence in the educational community.

A. 
Tips
1. 
Have an annual hosted meeting (possibly including a meal) where volunteers on the Learning for Life/Exploring committee, teachers using the senior high school program, and leaders of organizations with Exploring posts/clubs demonstrate to school officials their enthusiasm for Exploring's ability to help the schools.
2. 
Keep good lines of communication open with school administrators. The marketing team should plan regular visits to high school principals and counselors. School superintendents and boards should be informed about Learning for Life/Exploring.

3.
Emphasize that we are asking for only about 10 minutes of student time each year. In exchange, schools will get information that can help counselors with individual students and can support school curriculum and career education plans.
4.
Note that this career interest survey allows students to self-identify with career fields in which they are interested, as opposed to an aptitude test that tells students the areas in which they might excel. For this reason, the career interest survey can supplement an aptitude test that a school might already facilitate with their students.
5.
Start the conversation about the career interest survey with a career teacher or career counselor first, before any other school personnel. The people who work in these roles will already have an understanding for career education and will have more to discuss with you about a career interest survey.
6.
When you return survey results to schools, return them in chart or graph format.

B.
Overcoming Career Interest Survey Objections

1.   We don’t do surveys …


•
So how are you meeting state public law _______________ (look up your state’s 
career education law) requiring a four-year course curriculum plan?

· NOTE: Most states have a career education law that requires students, sometime between the sixth and eighth grades, have a course curriculum plan developed for the courses they should take to help them prepare for their career plans, i.e., if you want to be an architect, take these courses; if you want to be a dentist, take these courses. Find out your state’s law.
2.   We already do too many surveys …

•
How are those working for you? Are they meeting all of your needs?


•   
How much does that cost you each year?

•   
I’d bet your students are receiving junk mail solicitations now. Are they blaming you 



for that?

3.   We never received the results last time …

•
I can’t speak to that. I’m new and give you my word I will personally deliver them to 



you. Would you prefer hard copy or electronic results?

4.   We don’t release confidential information …

•
Good, we wouldn’t want you to. The U.S. Department of Education calls this “directory information”—information found in a school phone directory.  Please find a copy of the U.S. Department of Education’s letter in the Appendix.
5.   We have our own data …
•   
Great! Would you be willing to share the numbers? Not the names—just numbers. We can use that to set up real-world career experiences for your students. That’s what we do!


•   
When they say “yes”, respond: Now to be fair, we’re going to go talk with the hospital CEO, fire chief, police chief, and president of the bar association and help them organize career programs for a few hours a month. They are going to want to invite your students and their parents to an open house. … (pause) If I bring invitations back, would you make sure all the right students receive the invitations? 
(Wait for answer) I’d even be willing to sit in your office and put name labels on them for you if you print the labels.
•   
NOTE: This accomplishes the same intent of finding out how many students are 
interested in a career and gets an invitation sent to them.
6.   The principal has to approve it …


•
He/she isn’t in today, is he/she? Not right now? Would you introduce me?


7.   The school board already said no …

•
When did that happen? Why was that?



•
(If long ago) Would you help me get on the agenda? We have more to offer than a 




survey?



•
Do you have other career data you would share with us?


8.   What if the school has its own Career Interest Survey?


•
Ask to review the school's material. It may be that the Learning for Life survey is better. Learning for Life has gained much experience as a national organization in conducting this survey all over the nation.



•
Suggest that Learning for Life conduct the survey for the school to save its staff time. Perhaps our survey could replace theirs.



•
Ask whether you can get names from their survey for use by organizations using Learning for Life programs. In this case, you may no longer be in control, but this is better than having no names at all.



•
Try to persuade the school to conduct the Learning for Life survey because of the merits of involving their students in Learning for Life programs.
· Ask if their survey is costing them money and if so, promote the fact that you can provide the survey at no cost to the school.
C.  
U.S. Department of Education Support
Questions pertaining to the Family Educational Rights and Privacy Act (FERPA) or Protection of Pupil Rights Amendment (PPRA) laws.
The U.S. Department of Education, Family Policy Compliance Office supports the Career Interest Surveys. It has provided a letter (see appendix) outlining the methods that councils and schools can use to administer the Career Interest Survey without breaking FERPA (Family Educational Rights and Privacy Act) or PPRA (Protection of Pupil Rights Amendment) laws.
Refer to the appendix for:

· Cover letter to local councils

· Full, 3-page DOE letter of support

More information on FERPA:

http://www2.ed.gov/policy/gen/guid/fpco/ferpa/index.html 

More information on PPRA:

http://www2.ed.gov/policy/gen/guid/fpco/ppra/parents.html 
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A.
Online Career Interest Survey
The annual fee for a council to have access to its online survey data is based on the council’s classification:

	Council
Classification
	Annual Fee

	Any council that commits to participate in the 2016 Exploring Explosion*
	FREE

(Jan. 1 – Dec. 31, 2016)

	500
	$600

	400
	$700

	300
	$800

	200
	$900

	100
	$1,000


*For more information go to www.exploringexplosion.org.

B.
Scantron Career Interest Survey

The cost to councils for the Scantron survey forms could include:

1. Purchase of the forms from the National Distribution Center using the LFL Supply Order Form (download from the FORMS section of the LFL internal site in MyBSA). Pricing as of April 2016:
	SKU
	Item
	Qty
	Cost

	618833
	Scantron, 30 pk
	1
	$2.49 ea

	629090
	Scantron, 500 pk
	1
	$41.29 ea

	629090
	Scantron, 500 pk
	10-19
	$40.99 ea

	629090
	Scantron, 500 pk
	20+
	$37.19 ea



2. 
Shipping fees to send Scantron survey forms to the National Learning for Life/Exploring  Service Center to utilize the free scanning service with a two week turn around.


3.
Free scanning is offered through the national office but if you would like to purchase a Scantron scanner and the ScanTools software you may contact Scantron at scantronhelp@scantron.com for a pricing quote.
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The online Career Interest Survey has been developed to align with school districts across the country that are shifting to online and digital formats.

A.
Step-by-Step Summary
1. Be sure schools are capable and willing to facilitate an Online Career Interest Survey with their students. Work with schools to develop a structured delivery method on the school campus to be sure you capture as many students as possible.  (School Counselor “Warm-Up” letter in Appendix.)

2. Submit the Online Career Interest Survey Agreement (see Appendix) to the national office at exploring@lflmail.org and pay the annual fee.

3. Have each district check to be sure that all their schools are listed in the survey and to contact you if there are any missing.  Also make sure that the school names are spelled correctly.  Note: If any additional/changes need to be made contact us at exploring@lflmail.org. 
· Add Yes/No questions

· Add sponsors 

· Create images

4. After students have completed the survey, access the Online Career Interest Survey administration site at www.exploringyourcareer.com/welcome to set up a council administration account.  A maximum of five council staff members will be allowed access to the council administration site.
5. Generate reports for school use. We recommend the following reports be delivered to the school:

· Alphabetical roster

· Roster by career

· Roster by hobby

Evaluate results on each campus and determine the students’ top career interests using the “school summary” report. Identify business leaders within these industries in the community and visit with them about starting an Exploring program.
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To access the online career interest survey, scan the QR code or 

go to www.exploringyourcareer.com.
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B.
Step-by-Step Detailed Explanation
1.
School Buy-In and Structured Delivery Methods 
Discuss structured delivery methods with the school contact person in an effort to capture data on as many students as possible. Be sure you both agree on the timeline and method. Here are a few suggestions for setting a date and time to facilitate the surveys. No online data may be collected from students younger than 13 years old.  They must use the Scantron paper surveys.
· Some campuses have an advisory/homeroom/study period that every student has on his or her schedule. This is a perfect time to capture the entire student body.

· The school counselor will announce on the PA system at 11 a.m. (for example) that it’s time to stop for 10 minutes all over campus to complete the survey.

· No matter the grade level, every student has either an English class or a history class. The school contact person might decide that every history teacher facilitates the survey with all of his or her students.

· No matter the delivery method, provide a Teacher Instruction Sheet describing the steps that should be taken in each classroom (see appendix). 

2.
Online Career Interest Survey Agreement
Even if a council has not purchased access to the Online Career Interest Survey data, students can still complete the online survey. However, data will be available only to councils that have completed an agreement (see appendix) and submitted their payment to the National Learning for Life Office.

3.
Accessing Council Administration Site
Council users access the council administration site at www.exploringyourcareer.com/welcome. Council log-in information is provided via email after payment is received at the National Learning for Life office.
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a) Setting up a Council User Account
· Click on the New Users link, fill in your name, council name, and email address. Users create their own password. User accounts will be activated and remain active for one (1) year. For security reasons, users MUST use a scouting.org, bsamail.org, or lflmail.org email address. To set up an lflmail.org account, contact the Member Care Contact Center at 855-707-2644.
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Complete the form. You MUST use your scouting.org, bsamail.org, or lflmail.org email account.

· Select your council from the alphabetical drop-down list.
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· If you do not receive an email after three (3) days, contact 972-580-2418 for account activation.
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b)
Adding Yes/No Questions

· Click on Local Survey in the toolbar at the top of the page.

· Click on Add Local Survey to begin.
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· Select the school name from the drop-down menu.
· Name the survey.
· Enter up to six (6) questions.
· Save the survey or reset the form.
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c)
Creating, adding, and deleting sponsor logos
[image: image34.jpg]


Each council that purchases and is set up for the Learning for Life Online Career Interest Survey will have the ability to create, add, and delete sponsors for their council area survey. The sponsors will appear on the thank you page once the student completes the survey. Placement is in both the upper right and left corners. Up to two sponsor logos can be added. Each can be clickable to a designated link such as a website for the student to learn more about the sponsor. If no sponsors are scheduled to appear on the thank you page, a blank white space will appear.

· Click on Sponsors at the top of the page.
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Click on Add a Sponsor Image.
· Click on Browse to locate the image you want to add or type in the URL.

· Click on Upload Sponsor Image to add the image to the survey.
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· Once you have selected your logo image and inserted a URL link, you simply click on the Turn On or Turn Off buttons to make the logo image live on the Online Career Interest Survey thank you page. 
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4.   Generating Reports  (Online Career Interest Survey)
In December 2015, the “reports” section of the administration site underwent some major updates! One of the biggest changes from the previous report page is the ability to get reports from an online reports tool.  It is accessible from the “Reports” page in the administration tool of the page.  It can be found at the following address: http://exploringyourcareer.com/council/reports/ 
To access the page, the site does require the sign-in information that was previously provided to you. The reports section now contains the ability to access the main reports online.  You will find them prominently displayed on the bottom half of the page.  In order to get the information that you are looking to obtain, we have added some filters that will allow you to specify the information by School year, School name, Career and Hobby.  

1. First, you must select the year of data that you are looking to see. 
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2. Once you have selected the year, you will see the other options appear on the screen. 
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To Downlod the survey data:

Each category provides a dropdown that allows you to limit the data that is needed for you to be get to the data you desire.  Once you have the correct categories selected, you can press the “Filter Data” button and it will set the search  for a download to occur.  Then, press the “Microsoft Excel – All surveys (csv file)” button and it will download the survey data requested in an Excel spreadsheet.  Each time that you change any of the categories you will see the “Filter Data” button change to a “Re-filter Data” button.  You must press this in order for the new categories to be set.  Any mailing labels needed can then be done through the Microsoft Excel program for now.  A mailing label feature will be added to the this reports page soon.  
To view online reports:

On the bottom half of the page, you will also see links to Online Council Reports that are available as well. The process for this is very much the same.  You will be able to set the categories that you would like to see data.  Once that is set, you can click the “Filter Data” button and it will set the parameters for your search.  Then click the report that you would like to see and the data will populate into a webpage that is available for you to view.  To change the categories for your search simply go back to the parameters on the reports page, change the parameters and click the “Re-Filter Data” button.  You can then click on the “view” link on the report that you are interested in and the data will populate a web page with the results.  

The Access databases are currently not available and replaced with this online resource.  The Excel spreadsheets will remain available for you to use on a regular basis.  
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A.  Step-by-Step Summary
1.   Be sure schools are capable and willing to facilitate a Scantron survey with their students. Work with schools to develop a structured delivery method on the school campus to be sure you capture as many students as possible.

2.
Order your surveys (No. 618833) from the National Distribution Center (order form found at MyBSA>Resources>Learning for Life>Exploring>Forms). Fujitsu survey forms were discontinued January 1, 2015.
3.
Your office assigns each school a three-digit school code. It is your responsibility to save and keep track of your own school code assignments. Keep a master list.  Each student form must have the correct code number in order to produce reports using the report generator. The school code will be necessary later in the process (School codes are pre-assigned for the Online Career Interest Survey.)

4.   Determine whether you will be scanning the survey forms locally or sending the surveys to National for free scanning.
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5.
Proofread your Scantron forms BEFORE scanning them. Make sure:


a)
Students used No. 2 pencil, NOT PEN.


b)
All applicable bubbles are filled in. Proofread your surveys before you ship them. Fill in 

missing bubbles.

c)
The three-digit school code is bubbled in.


d)
Discard forms without student names OR career/hobby options completed.

e)   Complete the Free Scanning Form (see appendix) and place in box to be shipped.

6.
The report generator and ScanTools application files are compatible only with the forms 
ordered from the National Distribution Center. Copies of the forms or custom forms will 
not work.

7.   Generate Selective Reports for school use. We recommend the following reports be delivered to the school:

· Alphabetical Roster

· Career Interest Roster
· Cluster Interest Roster
8.
Reports useful to the council:

· Career/Hobby Summary by School – This will tell you how many students are interested in particular careers, which will guide you in approaching businesses about starting an Exploring program.

· Mailing labels for open house invitation letters.
9.   Evaluate results on each campus and determine the students’ top career interests. Identify business leaders within these industries in the community and visit with them about starting an Exploring program.
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B.
Step-by-Step Detailed Explanation
1.
School Buy-in and Structured Delivery Methods 
In an effort to capture data on as many students as possible, it is necessary to discuss survey facilitation options with the school contact person. Be sure you both agree on the timeline and method. Here are a few suggestions for setting a date and time to facilitate the surveys:

Some campuses have an advisory/homeroom/study period that every student has on his or her schedule. This is a perfect time to capture the entire student body.

· The school counselor will announce on the PA system at 11 a.m. (for example) that it’s time to stop for 10 minutes all over campus to complete the survey.

· No matter the grade level, every student has either an English class or a history class. The school contact person might decide that every history teacher facilitates the survey with all of his or her students.

· Distribute your forms to the schools. Remember to include the Teacher Instruction Sheet (see appendix) with each classroom set of surveys.

2.  
Scanning Options 
a) National Scanning:

If you do not have access to a Scantron/NCS scanner, you can take advantage of the scanning service provided by the National Service Center. Here’s how:

1. Complete the Scantron Scanning Council Form and Scantron Scanning School Form, see appendix. 
2. Proofread all Scantrons. Fill in empty/skipped bubbles with a No. 2 pencil.
3. Arrange all Scantrons so they are all face up and facing the same direction. If you do not arrange your Scantrons as directed, we cannot guarantee a quick turn around time.
4. Ship your Scantrons with a tracking number and the forms mentioned in #1 directly to the vendor at: SourceHOV, ATTN: BSA/Learning for Life, 2701 East Grauwyler Road, Irving, TX 75061. 
5. Within five business days you will receive an email with one .dlm file for each school.
b) National scanning vendor confidentiality statement
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 General Overview 
Compliance Individuals 
 Chief Security Officer 
 Chief Compliance Officer 
Compliance Program 
 Policies and Procedures 
 GAP Analysis 
 Risk Assessments 
 Security Awareness Training 
 Supporting Documentation: Evidence of Compliance 
Compliance Auditing 
 Internal Pre-Audit Process 
 On-going Monitoring Process 
 Internal Compliance Certification 
 External Customer Audits 
Focal Points 
·  Business Continuity Planning 

·  Disaster Recovery Planning 
·  Network and Data Security 
·  Intrusion Detection Systems 
SourceHOV is a global provider of transaction processing solutions, strategic consulting, and data analytics services that are delivered through innovative technology platforms and offer streamlined workflows based on specific business rules. Widely regarded as the national expert for conversion and data capture solutions, we capture 3.6 billion characters of data, scan 180 million images, and enter data from 8.5 million unique documents every month. 
Security Compliance 
SourceHOV falls within the Business Associate category under the Health Insurance Portability and Accountability Act (HIPAA) guideline. As such, we are contractually required to implement safeguards that securely protect the confidentiality, integrity, and availability of all health information received from and processed on behalf of those clients bound to HIPAA provisions. We utilize a multi-tiered security approach for protecting PHI that includes a combination of physical, electronic, and administrative safeguards. 
As a major outsourcing firm, SourceHOV’s extremely high levels of security routinely outperform our competitors. As dictated by project requirements, we maintain robust industry and governmental security compliant operations (e.g., SSAE 16 Type II, HIPAA, GLBA, SOX, PCI, FISMA, NIST, NARA, FIPS, DIACAP, etc.) that ensure the security of all data and documents received and processed on behalf of our clients. 
Physical Safeguards 
· Client work is performed in a secured area that is protected by key access reader technology and security camera monitoring. 

· Operations secure all wiring closets, communications centers, computer service rooms, and data centers to prevent any unauthorized access. 

· All employees are required to wear SourceHOV-issued identification badges at all times. 

· SourceHOV‘s document reconciliation program provides a full lifecycle audit trail 

· Servers and communication lines are located in a separate room within the IT Department. They also require individually assigned swipe card clearance –only IT staff that requires access to the server room is granted access. 

Administrative Safeguards 
· SourceHOV has a designated Security Officer who is responsible for developing and implementing all required policies and procedures, as well as manuals, guidance, and employee training. 

· Procedures clearly identify employees or classes of employees who will have access to hardcopy and electronic PHI/PII. Access to PHI/PII is restricted to only those employees who have a need for it to complete their job function. 

· Full background employee screenings that cover criminal/civil background checks, drug screening 

· Each SourceHOV staff member is required to sign a confidentiality/non-disclosure agreement upon employment, and will sign client-specific confidentiality agreements as indicated. 

· Procedures are in place to address and respond to actual or potential security breaches, to include written client notification of any non-permitted use or disclosure of PHI/PII. 

Technical Safeguards 
· All client processing, management and storage occur on an electronically segregated data repository instance. 

· All electronic client files are isolated from any other client data. 

· Access to client resources is restricted and based on a ‘need to know’ and segregated duties basis. 

· All user access is monitored and reviewed on a regular basis. 

· Breach of security systems are immediately reported in accordance with client requirements and a risk management plan installed to access and prevent further breaches. 

· Production workstations are not connected to local or networked printers or CD burners. Further, all workstation floppy drives and USB ports are disabled to prevent copying of data to any external media. Employees are not able to print or copy any documents. 

· Symantec antivirus software is deployed, updated, and maintained for all desktops, servers, firewalls. 

· SourceHOV regularly conducts vulnerability scans and assessments covering all internal, external, and third-party interconnects. 

· SourceHOV maintains firewalls to secure all perimeter entry points over the internet. In addition, networks are monitored 24x7 using intrusion detection systems through a leading managed security services provider. 

· All activity is logged and monitored for incident response and handling, and all internet-facing firewalls are logged and monitored on a 24x7 basis. 

· Image and data removal are compliant with NIST and FIPS security requirements. 

c)   Local Scanning:
For councils who own their own scanner or use a local junior college/college scanner

Requirements:

· Scantron scanner (purchased from Scantron)

· ScanTools software (purchased from Scantron)

· ScanTools application files (free at MyBSA>Resources>Learning for Life>Exploring>Program>Career Interest Surveys)

· Scantron survey form #618833 (purchased from National Distribution Center)
(1) Downloading ScanTools Application files to your computer – 

· The computer that works with the Scantron scanner MUST have ScanTools software installed and the ScanTools Application files loaded.  The ScanTools Application files will communicate to the computer that works with the Scantron scanner how to format the Career Interest Survey data to be compatible with the Career Interest Survey report generator.
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Go to MyBSA>Resources>Learning for Life>Exploring>Program>Career Interest Surveys to download the ScanTools Application Files.

· To copy the files to your computer double-click the file name. The window on the left will appear. Select Save as and then the location you would like to save your files to. The files will save as a .zip file and you will have to use WinZip to open them. You will not be able to open and read the application files; only the scanner can read them.
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· Open your ScanTools software. The window looks different depending on what version of ScanTools software you are using. They will all work very similarly.
· Click File.
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Select Install Application.

· Select the location on your computer where you saved the ScanTools Application files copied from MyBSA>Resources>Learning for Life>Exploring>Forms>Career Interest Surveys. There will be three (3) files: 678.$ep, 678-dlm.$cp, and Z678.SDS. You will not be able to open and view these files because they are strictly for formatting.
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· The Application file 678 – BOY SCOUTS Form 228381-1 is now available for use when scanning the Scantron Career Interest Survey forms.
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· The profile settings should be as follows: 
· Edit Profile: <None>
· Score Profile: <None> 
· Conversion Profile: 678-dlm
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(2)
Scanning the Surveys
•
Click on the Open button to the right of Data File.
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· In the drop-down window, select <New>.
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· Name your file and click on Create. Select your file name before scanning.  Load your scanner with your survey forms and click Scan to begin.
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· After the survey forms have been scanned, you must convert and save your scanned data as a .dlm or delimited file.
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3. Generating Reports 

a)
Downloading the Access Report Generator:
The Career Interest Survey Report Generator is a Microsoft Access program. You must have the complete version of Access installed on your computer for this to work.

· To begin loading the report generator, go to MyBSA>Resources>Learning for Life>Exploring>Forms>Career Interest Surveys and click on the Career Interest Survey Report Generator link.
[image: image59.jpg]AIM | INSTITUTE Sponsored by the following Local Sponsors q‘
careerl

nk.com

Thank you for participating
in the
Career Interest Survey

For more information on planning your future, go to:

Exploring.learningforlife.org

aAmmz»oP>O0

Based on your survey answers we have some
videos you might like to watch SALARY CALCULATOR

Watch a short video on: Chiropractor
Watch a short video on: Dentist

How much can you make by career and location

®»w oV - -

D





· Click Save as to save the file.
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· Select the location where you want to save the database and click Save.
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· Open the .mdb file to take you to the report generator.
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· Depending upon your version of Access, you may need to click on Enable Content and/or save the file with another name using Save As in order to change the file from read-only. 
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b)
Report Generation
NOTE: Each survey format – online and Scantron – requires a different report generator. The report generators are actually Microsoft Access databases. You will need a computer that already has Microsoft Access installed in order to use this tool. 

The report generator works with data from the Scantron scanner. To find the report generator to save to your computer go to MyBSA>Resources>Learning for Life>Exploring>Forms>Career Interest Surveys.

Your computer must have a complete version of Access installed in order for the report generating process to be successful.

(1)
Maintenance (Adding School Codes and “Yes”/”No” Questions)

· [image: image64.jpg]


Open the Career Interest Survey report generator. In the Main window, click on the Maintenance button. In the Maintenance window.

· Click on Enter/Edit Schools Information to input your three-digit school codes and school names. Save and exit to the Main window if you don’t have survey questions to add.
[image: image65.png]EXPLORING’

DISCOVER YOUR FUTURE

Career Interest Survey

“THIS SERVICE IS NOT INTENDED FOR USE BY PERSONS UNDER THE AGE OF 13,
IF YOU ARE UNDER 13 YEARS OLD, YOU MAY NOT USE THIS SERVICE OR PROVIDE ANY PERSONALLY IDENTIFIABLE INFORMATION.
For assistance on the suvey pleass email exploring@lfimail org

Personal Infomation

* First Name * Last Name * Address
* Month of Birth * Year of Birth *city * state *zip
Select v Select v Select v
* Gender * Ethnicity *Phone Email
Select v Select v

School Information

* Current Grade * After Graduation | want to: * Current School State

Select v Select v Select

* Current School City

Please Select a City

* Current School Name

Please Select a State and City




· Click on Enter/Edit Survey Questions to input the school code and six (6) “Yes”/”No” questions. Save and exit to the Main window.


(2)
Browse/Import Data
· Locate your data by using the Browse button. 
· Click on the .dlm file and select Open in the bottom right corner of the window to return to the Main window



· The file name and path for the file should appear in the Import Scan Data box. Now click the Import button and answer Yes to the prompt. You may import as many files as necessary, but you will have to import them one at a time. CAUTION: If you import a file more than once, you will have duplicate records in your reports. The only way to delete the duplicate files is to go into the Maintenance window and use Clear All Records. This will also clear all of your school codes and school names. You will be starting over.
(3)
Calculating Data

· After you have imported all of your .dlm files, click on Calculate and answer Yes to the prompt. When calculations are complete, you are ready to print the results. Any time you make changes to the report generator, click on Calculate to refresh or update your data.

(4)
Reports


At the Main window, click on Reports, and then click the Open button next to the type of report you need. 

(a)
Council Reports
Step 1 – Select the report you want from the list of reports that have been developed for you.

Step 2 –Click the button with the printer icon to go to a Print Preview window where you can either click on the Print icon to print your report or click on Exit (X) to return to the Council Reports menu.


NOTE: Career/Hobby reports in Print Preview are displayed together and you must minimize the report on top to view the other report.



(b)   Selective Reports
Step 1 – Select a report.
Step 2 – You will have different custom options depending upon your scanned data, maintenance information, and the report selection you made in Step 1. You can make up to five selections under each heading by clicking on the box to the left and then pressing Ctrl while clicking on your selections.
Step 3 –When you click on the printer icon (Step 3 in the image below) you will go to the print preview window where you can either click on the print icon to print your report or click on exit to return to the Selective Reports menu.

(c)
Mailing Labels
Step 1 – Choose the type of label you need.


Step 2 – You will have different custom options depending upon what selection you made in Step 1. You can make multiple selections in each box (school code, zip code, career, cluster, hobby, and grade). You can make up to five selections under each heading.

Step 3 – When you click on the Print icon, you will go to a Print Preview window where you can either click on the Print icon to print your labels or click on Exit (X) to return to the Mailing Labels menu.

(d)
Local Survey (yes/no questions) Results Report

Enter your school code and click Print for your survey question results. 

(e)
Saving Reports
In Print Preview mode, select the PDF or XPS option from the Data tab on the toolbar.



A. No Records Found
Why did I get this message?

Possible reasons:

· No .dlm file(s) were imported.
· You did not use the Calculate function to update files.
· School codes have not been entered into the Maintenance window.

· School codes in the Maintenance window do not match the codes in the scanned data.
· Scanned data was converted to a .dlm format in Excel instead of using the Scantron scanner.
· Your computer does not have a complete version of Microsoft Access installed.
B. Editing Your Scanned Data 
1. Open the Navigation Pane running vertically on the left side of your screen by clicking on the two arrows.


2. Open the Tables tab. If you are not already on the Tables tab, click the down arrow to open the menu and select Tables.
3. Under the Tables tab, double-click the ScanDataTbl file to open and see your data.


4. Any missing or bad data must be edited in order for the record to convert to Excel. Records with missing or bad data in the PostGrad, Career1, Career2, Rec1, or Rec2 fields will NOT convert to Excel. You can clean up your data in the ScanDataTbl table. You must SAVE your changes. To return to the Main window, minimize the ScanDataTbl file.


5. Click on the Calculate button to update your data and reports.


C. Converting a Database for Office 2013
The functionality to convert a database can be found in the File tab:
· Click the File tab in Access.
· Then click the Save & Publish button in the left bar.
· In the middle area, click the Save Database As button under File Types.
· In the right pane, select the format that you want to convert your database into, such as Access 2000 Database, Access 2002–2003 Database, etc.
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D.
Converting Career Interest Survey Data to an Excel Format

· Go to the Queries option in your Navigation Pane

· Double Click on AlphaRosterQry (your data with the career codes converted)


· Click on upper left-hand box of spreadsheet to select all of your data

· COPY

· Open Excel spreadsheet

· PASTE data

· Save file




	JAN-FEB
	MAR-MAY
	JUNE-AUG
	SEPT-NOV

	Facilitate career interest surveys on campus
	Analyze survey data for top student interests
	Schedule and Facilitate All In One Program Planning Meetings
	Support Open Houses

	Obtain schools' own career interest data
	Visit local businesses that match top interests
	
	Confirm school commitments for next Jan-Feb


Once you have conducted a career interest survey and know the interest of the students in your community, how do you find businesses and organizations to organize Exploring programs related to those interests and needs? Start with the following:

· Chamber of Commerce listings

· Information from public libraries

· Advice from district/Learning for Life office volunteers

· Professional organizations
· Listing of all educational programs, including public and private schools
· Council board members’ career fields
What to look for in a participating organization

· The business or organization is civic-minded and interested in youth.

· The business or organization has ample employees or members to provide leadership.

· The business or organization has sufficient program resources to support the students’ interest areas.

· You have sufficient survey names to recruit post or club participants. (On average, about 10 percent of those invited come to a first meeting.)
· The business or organizations has a need for a training program.

· The business or organization has an interest in starting an internship program.
· The business or organization would like to save money on employee training and turnover.
Large corporations and organizations might have potential for organizing several Exploring programs, possibly in different career areas. For example, the corporation might have an employee accounting club, flying club, etc., in addition to career programs.

Career Interest Survey Backdater
	BY DATE
	
	DATE COMPLETED

	
	Survey task force chairman recruited by marketing chairperson –90 days
	

	
	Survey task force members recruited –80 days
	

	
	Survey task force orientation –70 days
	

	
	Set target dates for survey completion –70 days
	

	
	Secure permission from public schools from top administration
–60 days
	

	
	Secure permission from private/parochial schools from top
administration –60 days
	

	
	Scan forms ordered (No. 618833) –60 days
	

	
	Determine how you will have the forms scanned; council’s Scantron scanner, local college, or national LFL office –60 days
	

	
	Identify guidance counselors in school district –50 days
	

	
	Meet with selected guidance counselors for their information needs from the results of survey –35 days
	

	
	Report generation program reviewed –30 days
	

	
	Print/copy teacher instruction sheet –20 days
	

	
	Create a master list of all your schools and assign each a unique
three-digit school code (examples: 000, 001, 002, etc.) –10 days
	

	
	Deliver scan forms to schools
	

	
	Pick up scan forms from schools +5 days
	

	
	If shipping your surveys to the national office for scanning, print 
the Free Scantron Survey Scanning Order Form (see appendix) and following shipping instructions +6 days
	

	
	Download report generator from MyBSA>Resources>Learning for
Life>Exploring>Marketing>Career Interest SSurveyr > Exploring > Marketing > Career Interest Survey
	

	
	Packaging of printouts for schools and guidance counselors +30
days
	

	
	Delivery of printouts to superintendents, principals, and guidance
counselors +35 days
	

	
	Task force after-action meeting to recognize people, evaluate, and
plan next year’s process +45 days
	


 
· Sample Scantron form.
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44
· FREE scanning order form
48
· Online career interest survey agreement
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TO:
Local council professionals

FROM:
National Learning for Life and Exploring Office

RE:
Career Interest Surveys

What to do with the attached letter from the U.S. Department of Education

We are excited to share the newest letter of support of the Career Interest Surveys from the U.S. Department of Education, Family Policy Compliance Office. The letter addresses the methods that councils and schools can use to administer the Career Interest Survey without breaking FERPA (Family Educational Rights and Privacy Act) or PPRA (Protection of Pupil Rights Amendment) laws.

So what should you do with this letter?

1.   Read it! Become familiar with the lingo, the laws, and the survey administration methods outlined within the letter.

2.   Become confident in explaining the different survey administration methods allowed.
3.   Provide a copy of the letter (without this cover sheet) to school administrators during your “sales pitch.” Whether or not they decide to utilize Learning for Life’s Career Interest Survey, the letter will allow you to build a transparent relationship with your local schools.

Keywords and phrases with which you should become familiar from reading the letter:

	Disclosure of PII
	FERPA
	PPRA

	LEA
	SEA
	Parents’ rights policy

	Education record
	DOE
	Eight protected areas


It’s also important to note that federal laws do not allow students under the age of 13 to take the online career interest survey. If they do, the data they enter will not be saved.
UNITED STATES DEPARTMENT OF EDUCATION
                                        OFFICE OF MANAGEMENT
                                  


 December 23, 2013
Dear Superintendents, Principals, and Guidance Counselors:
This is in response to a request from Learning for Life, a non-profit organization, to provide guidance to public schools involved in the Learning for Life Exploring program on the applicability of the Protection of Pupil Rights Amendment (PPRA) and the Family Educational Rights and Privacy Act (FERPA) when administering the Learning for Life Exploring (Exploring) Career Interest Survey (Exploring Survey) to students. Specifically, this letter discusses the applicability of PPRA and FERPA to the paper Exploring Survey utilized by many of Exploring’s associates around the country, as well as the Exploring Survey which students complete online.
The U.S. Department of Education (Department) is familiar with Exploring and its career education program designed to help young men and women from the 6th grade through 20 years old make more informed future career decisions by providing students with real-life career experiences. In order to find out in what careers students are interested, the Exploring Survey, which is voluntary, is administered to students. The Exploring Survey captures personally identifiable information (PII) such as name, address, email, gender, date of birth, phone number, school, grade, ethnicity, and career interests. The Department understands that the Exploring Survey is provided to students in one of three ways: (1) a Web site in which students provide direct response to the Exploring Survey and submit to Exploring through the Web site; (2) Exploring associates (“local executives”) around the country come into the schools, administer the Exploring Surveys, and take the completed Exploring Surveys with them; and (3) the local Exploring executives drop off the Exploring Surveys with guidance counselors or other school officials, who then give the Exploring Surveys, take them up, and return them to Exploring. The Exploring Survey results are provided to the schools for use by guidance counselors and Exploring programs in schools to assist students in making career decisions.
Local educational agencies (LEAs) and individual schools that receive funding under any program administered by the Department are obligated to be compliant with the requirements under PPRA and FERPA. Thus, schools must assure that the Exploring Survey is administered in a manner that is compliant with these laws. Below we discuss the provisions in PPRA and FERPA that may be applicable to the administering of the Exploring Survey.
Protection of Pupil Rights Amendment
The PPRA applies to the programs and activities of an LEA, or other recipient of funds under any program funded by the Department. The PPRA statute is found at 20 U.S.C. § 1232h. It governs the administration to students of a survey, analysis, or evaluation that concerns one or more of the following eight protected areas:
400 MARYLAND AVE. S.W., WASHINGTON, DC 20202-4500 www.ed.gov
The Department of Education's mission is to promote student achievement and preparation for global competitiveness by fostering national educational excellence and ensuring equal access.

1.   political affiliations or beliefs of the student or the student’s parent;
2.   mental or psychological problems of the student or the student’s family;
3.   sex behavior or attitudes;
4.   illegal, anti-social, self-incriminating, or demeaning behavior;
5.   critical appraisals of other individuals with whom respondents have close family relationships;
6.   legally recognized privileged or analogous relationships, such as those of lawyers, physicians, and ministers;
7.   religious practices, affiliations, or beliefs of the student or student’s parent; or
8.   income (other than that required by law to determine eligibility for participation in a program or for receiving financial assistance under such program).
We have been assured that none of these types of questions are being asked in the Exploring Survey. If that is the case, the right for parents to opt out of surveys that contain one or more of the eight protected areas would not apply to the Exploring Survey. However, you should be aware of another provision of PPRA that would relate to the Exploring Survey.
The PPRA requires LEAs to work with parents to develop and adopt policies on certain items, unless the LEA or State educational agency (SEA) established comparable policies on or before January 8, 2002. In relevant part, the LEA must adopt a policy that addresses the right of parents to inspect, upon request, a survey created by a third party before the survey is administered or distributed by a school to students and the procedure for granting a request by a parent for such access. (The survey does not have to include any of the eight protected areas of information listed above.) Accordingly, if the school administers the Exploring Survey, parents have a right to inspect, upon request, the survey before it is administered to students. Additionally, if a school does not have a policy in place about surveys, including third party surveys, then the school cannot issue the Exploring Survey until such a policy is implemented. See 20 U.S.C. § 1232h(c)(l)(A)(i). Depending on the school policy, parents may or may not have an opportunity to opt their children out of participation in the Exploring Survey.
Family Educational Rights and Privacy Act
FERPA is a Federal law that affords parents the right to have access to their children’s education records, the right to seek to have the records amended, and the right to have some control over the disclosure of information from the records. These rights transfer to the student when he or she turns 18 years of age or enters a postsecondary educational institution at any age (“eligible student”). Education records are those records that are directly related to a student and that are maintained by the school or LEA or a party acting for the school or LEA. Parents or eligible students must provide written consent prior to the disclosure of PII from education records to third parties, unless one of the exceptions to FERPA’s general consent requirement applies. The FERPA regulations are found at 34 CFR Part 99, which you can find on our Web site: http://www2.ed.gov/policy/gen/reg/ferpa/index.html.
While FERPA does not address whether or not a school may administer a survey to students, it does address whether a school can disclose completed surveys that include personally identifiable information to a third party. In the case of the Exploring Survey, there are two ways in which the completed Exploring Surveys may be shared with the Exploring executives. One way is to have parents and eligible students provide consent before disclosing the Exploring Survey to Exploring or any other party. A second way is to have local Exploring executives come into the schools, 

administer the Exploring Surveys, and take the completed Exploring Surveys with them. The Exploring Surveys administered in this scenario are not at any time maintained by the school or LEA or a party acting for the school or LEA, and thus would generally not meet the definition of an “education record” under FERPA.
Similarly, if students choose to take the Exploring Survey online at the Exploring Web site, FERPA would not generally apply as the Exploring Survey is not maintained by the school. However, the results of the students’ Exploring Surveys that include PII from student education records and are provided to and maintained by the school would meet the definition of an education record under FERPA. Thus, the PII in the Exploring Survey results maintained by the school can only be disclosed to a third party with the written consent of the parent or eligible student, unless an exception to the written consent provision applies. School officials should ensure that parents and students are informed of the purpose of the Exploring Survey, that it is being conducted by Exploring and not the school, and that their participation is completely voluntary. Further, if this is the case, school officials should also ensure parents and students that the completed Exploring Surveys are not going to be maintained by the school or become part of their education records.
For a more complete explanation of an LEA’s responsibility under both FERPA and PPRA, please see “Notices to LEAs and SEAs Regarding Responsibilities under FERPA & PPRA” on our Web site: http://www2.ed.gov/policy/gen/guid /:fpco/hottopicslindex.html . Additionally, if you have any questions about these laws in general or this letter in particular, please do not hesitate to contact us at FERPA@ed.gov or by calling (202) 260-3887.
Sincerely,
Dale King
Director
Family Policy Compliance Office
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Scantron© Scanning

Council Contact Information Form
Please fill in the below information so that we may email the data files to you after scanning. 

Council Number: _______________________


Council Name: _____________________________
 

Contact Person: ___________________________

Contact Phone: ____________________________

Contact email: _____________________________

Please include one copy of this form in 
each box of forms sent for processing.

Box _____ of ______.
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Scantron© Scanning

School Cover Sheet

Please fill out and place one of these sheets on top of each batch of Scantron© forms per school.
Council Number:_____________________

School Name:_____________________


School Code:_____________________



Online Career Interest Survey

AGREEMENT
To align with school districts across the country that are shifting to online and digital formats, the Online Career Interest Survey has been developed.

Access: The survey is accessed over a secure website at www.exploringyourcareer.com so that anyone with Internet access and a computer or smartphone may complete the survey, including home-school students. 

Data: Data will be available only to councils that have completed this application and submitted their payment. Online data is connected to an individual council based on student zip codes. The data is sent to a secure website that is accessed by password. Passwords to access data will be council assigned to a maximum of five council staff members. Raw data will be available to councils in an Excel spreadsheet or a delimited (.dlm) format. The delimited file is used in the Access Online Career Interest Survey Report Generator provided along with instructions. Schools will not have direct access to their results, but must obtain them from their local council.

Custom Survey Questions: The survey has a feature for adding six questions requiring a “Yes” or “No” response that can be customized for each school.

Sponsors: Each council will have the ability to create, add, and delete sponsors for their council area survey. The sponsors will appear on the thank you page once the student completes the survey. Placement is in both the upper right and left corners. Up to two sponsor logos can be added. Each can be clickable to a designated link such as a website for the student to learn more about the sponsor.

Price: The online career interest survey cost is an annual flat rate based on council classification and includes an unlimited number of schools and surveys. 

	Council
Classification
	Annual Fee

	Any council that commits to participate in the 2016 Exploring Explosion*
	FREE

(Jan. 1 – Dec. 31, 2016)

	500
	$600

	400
	$700

	300
	$800

	200
	$900

	100
	$1,000


    *For more information go to www.exploringexplosion.org.

School Names: School names are provided on a drop-down menu based on the state and city where the student attends school. All councils will have two generic options: “Home school” and “Other             ” in the event a school name is omitted. As schools change (open, close, merge, rename), councils can notify Learning for Life and the online survey can be updated quickly.

Questions: Please contact us at exploring@lflmail.org or 972-580-2418.
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Online Career Interest Survey
AGREEMENT
Council Name:  








 Council No.  


Contact Person:  












Email:  


 Phone:  




Street Address:  












City:  

 State:  

Zip:  


Upon receipt of this information at the Learning for Life national office, you will receive a confirmation notification and account activation instructions for setting up individual usernames and passwords at  www.exploringyourcareer.com/signin.
This Agreement and payment, if applicable, allows access to our council’s Online Career Interest Survey data for a

12-month period starting from our account activation date. Our council classification is 
_. 

















Scout Executive Printed Name


Scout Executive Signature


       
       Date
Please make checks payable and mail to: 
Learning for Life, 1325 West Walnut Hill Lane, Irving, Texas 75038
	Council
Classification
	Annual Fee

	Any council that commits to participate in the 2016 Exploring Explosion*
	FREE

(Jan. 1 – Dec. 31, 2016)

	500
	$600

	400
	$700

	300
	$800

	200
	$900

	100
	$1,000


*For more information regarding the 2016 Exploring Explosion go to www.exploringexplosion.org.
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EXPLORING EXECUTIVE INSTRUCTIONS
School Counselor “Warm-Up” Letter
The purpose of the school counselor “warm-up” letter is to introduce the Exploring
program, which will lead into a discussion about career interest surveys.
1.  Review the letter template on the next page and fill in the spaces with your own, local information.

2.  Include an Exploring sales kit (BIN SKU 622999) with the letter in the folder pocket inside the back cover.

3.  Aim to mail letters before spring break every year.

4.  OPTIONAL: Attach a list of current clubs/posts with contact information for each post
Advisor if you have an impressive list for your area.

5.  Follow up the letter with a phone call no more than two weeks after the letter is 
mailed. This is your chance to create credibility; don’t pass it up!

6.  Use the phone call to 1) schedule a face-to-face meeting, and 2) answer ONLY
their initial questions about the Exploring program.

7.  Use the face-to-face meeting to “sell” the Exploring program. When they express their approval of the program, suggest the career interest surveys either online or in Scantron form as a tool to match their students with your Exploring programs.


               

Before calling or meeting the counselor review the “Overcoming 
Career Interest Survey Objections” on page 7 in this guidebook.
(Date)
(School Counselor)
Dear (Name):
In light of the recent emphasis from the Department of Education on career education, I want to be sure that you are aware of the hands-on career Exploring programs in your community. Exploring is a unique career exploration program for young men and women in sixth grade and up. Our program provides an ideal link between the academic environment and the real world.

Students not only gain valuable experience to include on their college, job, and scholarship applications, but also develop a mentoring relationship with business professionals from the career field of their choice. You’ve heard the phrase “it takes a village to raise a child.” Exploring is that village! Adult volunteers are subject matter experts in their fields and are trained in age-appropriate program delivery. Consequently, the students gain knowledge in a specific career field as well as ethics, professionalism, and leadership skills, all of which will prepare them for their upcoming transition from school to career or work.

In our area, we have Exploring programs available to your students in the areas of:
· (Career Field)

· (Career Field)
· (Career Field)

These Exploring programs act as an extension of classroom content and after-school club experiences (i.e., FFA, HOSA, etc.).

I will contact you soon to evaluate the options in possibly matching your students with the Exploring programs in our community. In the meantime, please feel free to contact me using the information below.

Sincerely,

(LFL Professional)
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Teacher Instruction Sheet 
Online Career Survey

www.exploringyourcareer.com
Exploring is a career education program for high school–age young men and women based on a unique and dynamic connection between youth and the businesses in their communities. Local organizations are matched to the interests of young people in the community using the career interest survey. The result is a program of activities that helps youth pursue their special interests, grow, and develop. Many times these programs provide a hands-on experience, which could enhance financial success, career preparation, and college endorsements. Please ask the students to complete the five- to ten-minute online career interest survey. 
Instructions to students: 

1. Go to www.exploringyourcareer.com. If you are on a mobile device, consider tilting your device to a landscape position so you can view content more easily.
2. Choose your top two (2) career choices and top two (2) hobby choices by selecting "1st choice" and "2nd choice" next to your selections.

3. Click "Submit" at the very bottom of the page after making your four (4) selections.
4. Your response on the survey may result in an invitation by a local company, business, or organization for you to participate in a hands-on career program in a field in which you have selected as one of your interests. Your personal information WILL NOT be shared with others.



Teacher Instruction Sheet  |  Scantron Career Survey



School Name: ____________________________________3-Digit School Code: *_______________


PLEASE READ THE FOLLOWING TO STUDENTS PRIOR TO FILLING OUT SURVEY:
· Your responses to this survey may result in an invitation by a company, business, or organization to participate in a program in a career interest you have chosen.”  
· “Please choose your responses carefully”
· “Using a #2 pencil (NO PEN), fill in your name, address, date of birth, and phone number.”
· “Leave space between your house number and street name for address.  Please fill in the blank circles for the spaces between your house number and the name of your street.  If you do not fill in the blank circles, the computer cannot read your address correctly.”
· “Fill in each circle completely under your name and address using heavy, dark marks.”
· “Fill in the 3-digit Career Interest Survey code (assigned by Exploring representative), which is ____   ____   ____”
· “Do not make stray marks on the form and do not fold the form.”
· “Please erase cleanly any mark you want to change.”
· “From the codes on the back, select your top 2 career choices, and top 2 hobby choices, and place those code numbers where indicated on the lower right front of the form.”
· If your school elects to utilize the ‘yes/no’ questions: “Please answer YES or NO to the following six questions.” Each school determines the questions to be asked, but all students must answer the same six questions.
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Dear Student,

We are pleased to invite you to take an opportunity to learn more about potential careers in Engineering and Technology. Through a partnership between the Penn State Behrend School of Engineering and American Institute of Architects, we have developed a program specifically for high school students. We will be diving into several career paths including Mechanical Engineering, Plastics, Industrial Engineering, Computer Science, Electrical Engineering, Manufacturing, and Software Engineering.

There will be an open house held on Wednesday, November 19th from 6:00 pm to 7:30 pm in the Samuel Black Conference Center at the Burke Center located on the campus of Penn State Behrend. Parking is located in the adjacent parking garage. This session will provide you with an orientation for the Explorer Program and more details about the program. You’ll have the opportunity to experience a wide variety of engineering careers, explore top engineering facilities, and most importantly start down the path to a rewarding career!

This program is the first of its kind here in Erie and we hope you’ll join us for a great year. Our meetings will typically be once each month from December through May. If you decide to join the Engineering Explorers there is a registration fee of $25 which may be paid at the open house. Checks may be made payable to “French Creek Council.” 

If you have any questions or cannot attend the open house please contact Jared Magoon at 814-868-5571 or jared.magoon@scouting.org. Please feel free to bring your friends who may have similar career interests.

Sincerely,

Exploring Executive

Learning for Life™
This guidebook can be downloaded in Word format from � HYPERLINK "http://www.exploringexplosion.org" �www.exploringexplosion.org�� so you can customize your own resources in the appendix.





SECTION 1:  Purpose





HOW MANY SURVEYS DO I NEED?


Membership Goal  x  20  =  Number of surveys needed





SECTION 2:  At a Glance





Councils that commit to participate in the 2016 Exploring Explosion will be granted FREE access to the Online Career Interest Survey from January 1 to December 31, 2016.





SECTION 3:  Marketing/Promoting





SECTION 4:  Cost to Council





SECTION 5:  Online Career Interest Survey Process





“Since 2010, our school district has implemented a bold vision we call Going GLOBAL (Growing Learning Opportunities Beyond All Limits).  Providing adequate technology tools and resources is essential to fulfilling this vision.   In grades 6-12, all Rutherford County Schools' students are provided a laptop computer for use at school and at home.  Because this 1:1 access to technology allowed our students to easily and quickly participate in the career interest survey, additional career Exploring programs are being created by the Boy Scouts of America to help our students determine career paths that most closely align to their interests and talents.  I appreciate local Scouting Professional, Travis Walker, our teachers, and our administrative staff for their efforts in creating new learning opportunities for our students.”


Janet H. Mason, Ed. D. �Superintendent�Rutherford County Schools - North Carolina

















SECTION 6:  Scantron Career Interest Survey Process
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SECTION 7:  Scantron Troubleshooting





If you need additional troubleshooting assistance, you may get technical support by entering an incident report in MyBSA using the Online Support Center located in the support gadget on the home page or call the Member Care Center at 1-855-707-2644. 








If you need additional troubleshooting assistance, you may get technical support by entering an incident report in the Online Support Center located in the Support gadget on the MyBSA home page. Or call the National Support Center at 1-855-707-2644. As this number is for national and local council employees only, please do not publish this technical support number.








SECTION 8:  Annual Work Schedule





THE MAGIC NUMBER!


Membership Goal  x  20  =  Number of surveys needed





SECTION 9:  Appendix





BSA National Distribution Center


SKU 618833 – 30 pk


SKU 629090 – 500 pk
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Office use only: 67001-1064








TIP!





* Enter 3-digit code
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